Examples Guide: MSP430 SMBus Library

1 Introduction

This document is intended for the person evaluating the MSP430 SMBus Library. The API is accompanied by many examples that demonstrate its use; this document describes how to run those examples, and provides commentary on how they were written.

For detailed information on developing with the SMBus Library, please see the MSP430 SMBus Library User’s Guide.

Table of Contents

1 Introduction........................................................................................................................................... 1
  1.1 Supported Devices.............................................................................................................................2
  1.2 Summary of the Examples ..................................................................................................................2

2 Running the Examples .......................................................................................................................... 3
  2.1 Obtaining Code Composer Studio or IAR Kickstart ........................................................................3
  2.2 Hardware Support ...............................................................................................................................3
  2.3 Opening and building the examples ..................................................................................................5
    2.3.1 IAR Projects .................................................................................................................................5
    2.3.2 CCS projects .................................................................................................................................7

3 Example Descriptions ............................................................................................................................ 9
  3.1 General Instructions...........................................................................................................................9
    3.1.1 Nomenclature ...............................................................................................................................9
    3.1.2 Hardware Connection ..................................................................................................................9
    3.1.3 Building and executing the examples .........................................................................................10
  3.2 00_AllProtocols ...............................................................................................................................11
    3.2.1 Master Implementation ...............................................................................................................11
    3.2.2 Slave Implementation ...............................................................................................................12
    3.2.3 Executing the Example ..............................................................................................................17
  3.3 01_ReadByte_Echo ............................................................................................................................19
    3.3.1 Master Implementation ...............................................................................................................19
    3.3.2 Slave Implementation ...............................................................................................................19
    3.3.3 Executing the Example ..............................................................................................................20
  3.4 02_WriteWord_Dimmer .....................................................................................................................20
    3.4.1 Master Implementation ...............................................................................................................21
    3.4.2 Slave Implementation ...............................................................................................................21
    3.4.3 Executing the Example ..............................................................................................................22
1.1 Supported Devices

The SMBus library and examples were developed and tested in the following MSP430 families of devices:

Table 1: MSP430 Devices supported by SMBus Library examples

<table>
<thead>
<tr>
<th>Device</th>
<th>SMBus/I²C Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSP430FR59xx</td>
<td>Enhanced Universal Serial Communication Interface (eUSCI)</td>
</tr>
<tr>
<td>MSP430G2xx3</td>
<td>Universal Serial Communication Interface (USCI)</td>
</tr>
</tbody>
</table>

The code examples and the SMBus library can be implemented in different derivatives of the same family with little effort; and they can be migrated to other MSP430 devices with the same SMBus/I²C interface with some considerations such as pin usage, memory and timeout-timer availability.

1.2 Summary of the Examples

Each example in this software package is provided with full source code and including the necessary project files to build the project in IAR or CCS.

The examples, with the corresponding role and slave address are listed in Table 2.

Table 2: Examples implemented in SMBus Library

<table>
<thead>
<tr>
<th>Name</th>
<th>Role</th>
<th>Slave Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMB_Master00_AllProtocols</td>
<td>Master</td>
<td>0x43</td>
</tr>
<tr>
<td>SMB_Slave00_AllProtocols</td>
<td>Slave</td>
<td></td>
</tr>
<tr>
<td>SMB_Master01_ReadByte_Echo</td>
<td>Master</td>
<td>0x43</td>
</tr>
<tr>
<td>SMB_Slave01_ReadByte_Echo</td>
<td>Slave</td>
<td></td>
</tr>
<tr>
<td>SMB_Master02_WriteWord_Dimmer</td>
<td>Master</td>
<td>0x43</td>
</tr>
<tr>
<td>SMB_Slave02_WriteWord_Dimmer</td>
<td>Slave</td>
<td></td>
</tr>
</tbody>
</table>

The hardware used by each example is described in more detail in Section 2.2 and their functionality is explained in Section 3.
2 Running the Examples

2.1 Obtaining Code Composer Studio or IAR Kickstart

The SMBus Library and examples build and run on both the IAR and Code Composer Studio (CCS) environments for MSP430. See the Release Notes HTML file in the SMBus Library package for specific IAR/CCS version information.

IAR and CCS are both available in free, code-size-limited versions (8K and 16K, respectively, of object code). Applications that require less than 8K of memory can be run on both free versions. Applications that require more than 8K of memory cannot be built using the free IAR Kickstart tool. Instead, the free version of CCS can be used, or a licensed version of either environment.

2.2 Hardware Support

Most of the examples can run on any hardware TI sells in the eStore, supporting the devices mentioned in Table 1. This includes:

- FR5969 LaunchPad (MSP-EXP430FR5969)
- MSP430 Value Line Launchpad (MSP-EXP430G2)
- Any FET target board for supported MSP430 derivatives

Every example has a HAL layer which can be used to initialize ports, clocks and any other hardware used by the application and SMBus layers.

The following tables list the resources used by the examples:

Table 3: Hardware resources for example 00_AllProtocols

<table>
<thead>
<tr>
<th>SMB_Master 00_AllProtocols</th>
<th>Description</th>
<th>MSP430FR59xx</th>
<th>MSP430G2xx3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I2C</td>
<td>eUSCI_B0</td>
<td>USCI0</td>
<td></td>
</tr>
<tr>
<td>I2C_SDA</td>
<td>P1.6/UCB0SDA</td>
<td>P1.7/UCB0SDA</td>
<td></td>
</tr>
<tr>
<td>I2C_SCL</td>
<td>P1.7/UCB0SCL</td>
<td>P1.6/UCB0SCL</td>
<td></td>
</tr>
<tr>
<td>LED0</td>
<td>P1.0</td>
<td>P1.0</td>
<td></td>
</tr>
<tr>
<td>LED1</td>
<td>P4.6</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SMB_Slave 00_AllProtocols</th>
<th>Description</th>
<th>MSP430FR59xx</th>
<th>MSP430G2xx3</th>
</tr>
</thead>
<tbody>
<tr>
<td>I2C</td>
<td>eUSCI_B0</td>
<td>USCI0</td>
<td></td>
</tr>
<tr>
<td>I2C_SDA</td>
<td>P1.6/UCB0SDA</td>
<td>P1.7/UCB0SDA</td>
<td></td>
</tr>
<tr>
<td>I2C_SCL</td>
<td>P1.7/UCB0SCL</td>
<td>P1.6/UCB0SCL</td>
<td></td>
</tr>
<tr>
<td>LED0</td>
<td>P1.0</td>
<td>P1.0</td>
<td></td>
</tr>
<tr>
<td>LED1</td>
<td>P4.6</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>ADC</td>
<td>P2.4/A7</td>
<td>P1.4/A4</td>
<td></td>
</tr>
<tr>
<td>Hardware Resources for Example 01_ReadByte_Echo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SMB_Master</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01_ReadByte_Echo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C_SDA P1.6/UCB0SDA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C_SCL P1.7/UCB0SCL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED0 P1.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED1 P4.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SMB_Slave</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01_ReadByte_Echo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C_SDA P1.6/UCB0SDA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2C_SCL P1.7/UCB0SCL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED0 P1.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED1 P4.6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hardware Resources for Example 02_WriteWord_Dimmer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SMB_Master</strong></td>
</tr>
<tr>
<td>02_WriteWord_Dimmer</td>
</tr>
<tr>
<td>I2C</td>
</tr>
<tr>
<td>I2C_SDA P1.6/UCB0SDA</td>
</tr>
<tr>
<td>I2C_SCL P1.7/UCB0SCL</td>
</tr>
<tr>
<td>LED0 P1.0</td>
</tr>
<tr>
<td>LED1 P4.6</td>
</tr>
<tr>
<td><strong>SMB_Slave</strong></td>
</tr>
<tr>
<td>02_WriteWord_Dimmer</td>
</tr>
<tr>
<td>I2C</td>
</tr>
<tr>
<td>I2C_SDA P1.6/UCB0SDA</td>
</tr>
<tr>
<td>I2C_SCL P1.7/UCB0SCL</td>
</tr>
<tr>
<td>LED0 P1.0</td>
</tr>
<tr>
<td>LED1 N/A</td>
</tr>
</tbody>
</table>
### 2.3 Opening and building the examples

The SMBus Library examples have the following structure:

```
<install>
|--driverlib         <- MSP430 driverlib used to access MSP430 peripherals
|--smbuslib          <- Contains the SMBus library itself
|--examples
|   |--MSP430*       <- MSP430 device supported by examples
|       |-- CCS
|       |   |-- SMB*.projectspec <- Individual project files for CCS
|       |-- IAR
|       |   |-- SMB*
|       |       |-- *.ewd/ewp <- Individual project files for IAR
|       |       |-- *.eww   <- Workspace for individual projects
|       |   |-- SMBus_Examples_Workspace.eww <- Workspace containing all examples
|       |-- Src
|       |   |-- SMB*
|       |       |-- main.c  <- The example’s main code
|       |       |-- *_HAL.c/h <- Hardware abstraction for example
|       |       |-- *.c/h   <- Other source files used by application
```

#### 2.3.1 IAR Projects

The IAR projects are grouped within workspaces. There is one workspace containing all examples and individual workspaces for each project.

To use the examples in IAR, open the corresponding workspace file (*.eww) by selecting File→Open→Workspace.

After doing so, one of the projects in the workspace will be highlighted in bold; this is the active project. If a different example is desired, right-click on it and select “set as active”. If the workspace only has one project, this will be the only option.
If desired, the active project can also be selected by clicking on the corresponding project at the bottom of the workspace window. This will only show the files used by the Active project in the workspace window as shown in the following figure:

**Figure 1: Active project in IAR**

**Figure 2: Individual project view in IAR**
The project can be built using F7, Menu→Project→rebuild All, or ; and downloaded using Ctrl+D, Menu→Project→Download and Debug, or .

The example can now be executed.

2.3.2 CCS projects

The CCS projects are not grouped in workspaces. They need to be imported into a workspace of your choosing. The projects are defined by *.projectspec files, which contain the information CCS needs to import the project.

Open CCS, and choose Project → Import CCS Eclipse Project. Browse to the \CCS directory (containing the .projectspec files) of the example you wish to open. CCS will show a list of all the projects that were discovered in this directory.

Select all or any of the projects and click on “Finish”. The project(s) should appear in the Project Explorer.

![Importing CCS projects](image)

**Figure 3: Importing CCS projects**
The active project can be selected by simply left-clicking on the project and it will be highlighted with bold letters as shown in the following figure:

![Active project in CCS](image)

**Figure 4: Active project in CCS**

The project can be built using Ctrl+B, Menu → Project → Build All, or ; and downloaded using F11, Menu → Run → Debug, or ).

The example can now be executed.
3 Example Descriptions

3.1 General Instructions

This section contains instructions that are common to all SMBus examples.
Specific instructions for each example are provided after these general instructions.

3.1.1 Nomenclature

The SMBus protocols shown for all examples have the following syntax:

Example:

```
1 7 1 1 8 1 8 1 1
S SlaveAddr Rd A Data A [PEC] [A] P
```

- **S**: Start/Repeated Start
- **SlaveAddr**: Slave address (found in Table 2)
- **Wr**: Write bit (0)
- **Rd**: Read bit (1)
- **A**: Acknowledge (‘1’ = NACK, ‘0’ = ACK)
- **P**: Stop
- **[PEC]**: Optional PEC if enabled
- **[A]**: Optional ACK/NACK slot if PEC is enabled

3.1.2 Hardware Connection

A basic connection shown in Figure 5 between Master and Slave is required in order to execute the examples.
The pins used for SDA and SCL for the supported derivatives are described in Section 2.2.

The value of the pull-up resistors (Rp) will depend on the system’s VDD and the bus’ capacitance. Typical values are in the range of 1KΩ-10KΩ.

### 3.1.3 Building and executing the examples

1. Select an example from Table 2. All examples include projects and source code for both a master device and a slave device. These examples are named as follows:
   - SMB_MasterXX_NameOfProject
   - SMB_SlaveXX_NameOfProject

2. Select a MSP430 device for the master and slave. All projects can be executed in the supported devices listed in Table 1. Note that the master and slave don’t have to be from the same family of devices necessarily.

3. Connect master and slave devices as described in Section 3.1.2.

4. Open, build and download the corresponding projects as described in Section 2.3.

5. Check the results as described in the “Executing the Example” section of the individual example.
3.2 00_AllProtocols

The purpose of this example is to show the implementation of all the SMBus 2.0 protocols.

3.2.1 Master Implementation

The example sends each protocol one by one as shown in the following flow diagram:

![Flow Diagram](image)

**Figure 6: Master00_AllProtocols flow diagram**

The data sent for each command can be modified as needed, but the default example expects the following behavior:

- *QuickCMD*: The slave should simply toggle its LED0
- *SendByte*: Sets the pointer to read the Demo Version
- *ReceiveByte*: Reads the pointer which is expected to be the Demo version set by *SendByte*
- *WriteByte*: Writes the value 0xAA to the slave’s IOPort (more details in Section 3.2.2)
- *ReadByte*: Read IOPort (more details in Section 3.2.2)
- *ReadWord*: Read ADC result from slave (more details in Section 3.2.2)
- *ProcessCall*: Gets the result of multiplying 02h x 10h
- *BlockWrite*: Write a string on the slave
- *BlockRead*: Reads the string written in *BlockWrite*
- *BlockWBlockR-ProcessCall*: Calculate CRC of three bytes: 01h, 02h, 03h
3.2.2 Slave Implementation

The slave implements different commands using various SMBus protocols. The list of commands is shown in the following table:

**Table 6: Slave00_AllProtocols – Slave commands**

<table>
<thead>
<tr>
<th>Function</th>
<th>CMD</th>
<th>SMBus Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick_Led_Toggle</td>
<td>-</td>
<td>QUICK_COMMAND</td>
</tr>
<tr>
<td>Read_Reg_Ptr</td>
<td>-</td>
<td>RECEIVE_BYTE</td>
</tr>
<tr>
<td>Set_Reg_Ptr</td>
<td>00h-03h</td>
<td>SEND_BYTE</td>
</tr>
<tr>
<td>Write_Reg</td>
<td>10h-13h</td>
<td>WRITE_BYTE</td>
</tr>
<tr>
<td>Read_Reg</td>
<td>20h-23h</td>
<td>READ_BYTE</td>
</tr>
<tr>
<td>Read_ADC_ch</td>
<td>30h</td>
<td>READ_WORD</td>
</tr>
<tr>
<td>Mult_Bytes</td>
<td>40h</td>
<td>PROCESS_CALL</td>
</tr>
<tr>
<td>Write_String</td>
<td>50h</td>
<td>BLOCK_WRITE</td>
</tr>
<tr>
<td>Read_String</td>
<td>51h</td>
<td>BLOCK_READ</td>
</tr>
<tr>
<td>Calc_CRC</td>
<td>60h</td>
<td>BLOCKW_BLOCKR_PROCESS_CALL</td>
</tr>
</tbody>
</table>

* For a description of the SMBus Protocols, please refer to the [SMBus 2.0 specification](#).

The functions of the commands are very simple, but they are intended to be used for demonstration purposes or as a template for developers. These functions are described in more detail in the following sections.

3.2.2.1 Quick_Led_Toggle

**Description:** Toggles LED0.

**Protocol:** Quick Command.

**Format:**

```
 1 7 1 1 1
S SlaveAddr Wr A P
```
3.2.2.2 Read_Reg_Ptr

**Description:** Read the contents of a virtual register pointer, initialized to Reg0, or set by Set_Reg_Ptr. The slave defines the following 4 virtual registers:

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reg0</td>
<td>SMBus Status (check definition of SMBus_Status in SMBus Library documentation)</td>
</tr>
<tr>
<td>Reg1</td>
<td>SMBus Control (check definition of SMBus_Control in SMBus Library documentation)</td>
</tr>
<tr>
<td>Reg2</td>
<td>IOPort. When written, it writes to PxOUT register of the IOPort defined in Table 3; when read, it reads PxIN register of the same IOPort. Note that an Input switch defined in Table 3 is implemented in the same IOPort, allowing users to read the status of the switch by reading Reg2.</td>
</tr>
<tr>
<td>Reg3</td>
<td>Demo Version. Read-only register returning the version.</td>
</tr>
</tbody>
</table>

**Protocol:** Receive Byte

**Format:**

```
1 7 1 1 8 1 8 1 1
S SlaveAddr Rd A Resp A [PEC] [A] P
```

**Resp:** Contents of virtual register

3.2.2.3 Set_Reg_Ptr

**Description:** Changes the virtual register pointer. The contents of the register can then be read using Read_Reg_Ptr.

**Protocol:** Send Byte

**Format:**

```
1 7 1 1 8 1 8 1 1
S SlaveAddr Rd A CMD A [PEC] [A] P
```

**CMD:**

- 0x00: Change pointer to Reg0
- 0x01: Change pointer to Reg1
0x02: Change pointer to Reg2
0x03: Change pointer to Reg3

3.2.2.4 Write_Reg

Description: Writes directly to a virtual register defined in Table 7.

Protocol: Write Byte

Format:

<table>
<thead>
<tr>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>SlaveAddr</td>
<td>Rd</td>
<td>A</td>
<td>CMD</td>
<td>A</td>
<td>Data</td>
<td>A</td>
<td>[PEC]</td>
<td>[A]</td>
<td>P</td>
</tr>
</tbody>
</table>

CMD:

0x10: Write Reg0
0x11: Write Reg1
0x12: Write Reg2
0x13: Write Reg3

Data: Byte written to virtual register.

3.2.2.5 Read_Reg

Description: Return the contents of a virtual register defined in Table 7.

Protocol: Read Byte

Format:

<table>
<thead>
<tr>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>SlaveAddr</td>
<td>Wr</td>
<td>A</td>
<td>CMD</td>
<td>A</td>
<td>S</td>
<td>SlaveAddr</td>
<td>Rd</td>
<td>A</td>
<td>Resp</td>
<td>A</td>
<td>[PEC]</td>
<td>[A]</td>
<td>P</td>
<td></td>
</tr>
</tbody>
</table>

CMD:

0x20: Read Reg0
0x21: Read Reg1
0x22: Read Reg2
0x23: Read Reg3

Resp: Contents of the virtual register.
3.2.2.6  Read_ADC_ch

**Description:** Return the latest ADC result of the channel specified in Table 3. Note that this example performs continuous conversions of the ADC channel triggered by a timer.

**Protocol:** Read Word

**Format:**

<table>
<thead>
<tr>
<th>SlaveAddr</th>
<th>Wr</th>
<th>A</th>
<th>CMD</th>
<th>A</th>
<th>S</th>
<th>SlaveAddr</th>
<th>Rd</th>
<th>A</th>
<th>RespL</th>
<th>A</th>
<th>RespH</th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>1</td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>8</td>
<td>1</td>
</tr>
</tbody>
</table>

CMD: 0x30

RespL/RespH: Latest ADC result.

3.2.2.7  Mult_Bytes

**Description:** Returns the result of the multiplication of two bytes.

**Protocol:** Process Call.

**Format:**

<table>
<thead>
<tr>
<th>SlaveAddr</th>
<th>Wr</th>
<th>A</th>
<th>CMD</th>
<th>A</th>
<th>Data1</th>
<th>A</th>
<th>Data2</th>
<th>A</th>
<th>S</th>
<th>SlaveAddr</th>
<th>Rd</th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>8</td>
<td>1</td>
<td>8</td>
<td>1</td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>7</td>
<td>1</td>
</tr>
</tbody>
</table>

CMD: 0x40

Data1/Data2: Multiplier and multiplicand

RespL/RespH: Result of multiplication

3.2.2.8  Write_String

**Description:** Write a string in memory.

**Protocol:** Block Write

**Format:**
Examples

Guide: MSP430 USB API Examples

16

<table>
<thead>
<tr>
<th>1</th>
<th>7</th>
<th>1</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>8</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>SlaveAddr</td>
<td>Wr</td>
<td>A</td>
<td>CMD</td>
<td>A</td>
<td>Len</td>
<td>A</td>
<td>Data1</td>
<td>A</td>
<td>...</td>
<td>DataN</td>
<td>A</td>
<td>[PEC]</td>
<td>[A]</td>
</tr>
</tbody>
</table>

**CMD:** 0x50

**Len:** Length of string (1 to 32)

**Data1...DataN:** 1 to 32 bytes of data which will be written to string

### 3.2.2.9 Read_String

**Description:** Return a string stored in memory.

**Protocol:** Block Read

**Format:**

| 1 | 7 | 1 | 1 | 8 | 1 | 8 | 1 | 1 | 7 | 1 | 1 | 8 | 1 | 8 | 1 | 1 |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| S | SlaveAddr | Wr | A | CMD | A | S | SlaveAddr | Rd | A | Len | A | Resp1| A | ... |
| 8 | 1 | 8 | 1 | 1 |

**CMD:** 0x51

**Len:** Length of string (1 to 32)

**Resp1...RespN:** 1 to 32 bytes of data with the contents of the string

### 3.2.2.10 Calc_CRC

**Description:** Calculates and returns the CRC of an array of bytes.

**Protocol:** Block Write Block Read Process Call

**Format:**

| 1 | 7 | 1 | 1 | 8 | 1 | 8 | 1 | 8 | 1 | 8 | 1 | ... | 8 | 1 | 1 | 7 | 1 | 1 |
| S | SlaveAddr | Wr | A | CMD | A | Len | A | Data1 | A | ... | DataN | A | S | SlaveAddr | Rd | A |
| 8 | 1 | 8 | 1 | ... | 8 | 1 | 8 | 1 | 1 |

**RespLen** | A | **Resp1** | A | ... | **RespN** | A | [PEC] | [A] | P |

**CMD:** 0x60
Len: Length of the array of bytes (1 to 32)
Data1...DataN: Array of data
RespLen: Array of data in response (2 bytes for CRC)
Resp1…RespN: Result of CRC

3.2.3 Executing the Example

Follow the steps described in Section 3.1.3 to load the example to both devices.

Executing the example should result in the Slave device toggling LED0 at a fast frequency due to QuickCMD and/or WriteByte.

The results can be better observed by debugging the devices or using a logic analyzer. Using the first approach, the master application can be executed step-by-step in IAR or CCS observing the responses.

Figure 7 shows the results of executing the “ReceiveByte” command which will return the contents of the Reg3 (Demo Version).
Figure 7: Debugging 00_AllProtocols example in CCS

The results can also be observed with a logic analyzer as shown in Figure 8.

Figure 8: Results of 00_AllProtocols example using Logic Analyzer
3.3 01_ReadByte_Echo

This example shows a very basic implementation of ReadByte commands with a slave echoing the byte received from the master.

3.3.1 Master Implementation

The master sends an incrementing command using the Read Byte protocol. Waits for the response and checks if the response is the same as the command sent. This is shown in the following flow diagram:

Figure 9: Master01_ReadByteEcho flow diagram

3.3.2 Slave Implementation

The slave device in this application simply echoes the command sent by the master. It doesn’t have any specific commands assigned or makes any distinction between them.

For a description of the SMBus Read Byte protocol, please refer to the SMBus 2.0 specification.
3.3.2.1 Echo Command

**Description:** Returns an echo of the Command

**Protocol:** Read Byte

**Format:**

<p>| | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>SlaveAddr</td>
<td>Wr</td>
<td>A</td>
<td>CMD</td>
<td>A</td>
<td>S</td>
<td>SlaveAddr</td>
<td>Rd</td>
<td>A</td>
<td>Resp</td>
</tr>
</tbody>
</table>

**CMD:** Any value

**Resp:** Echo of CMD

3.3.3 Executing the Example

Follow the steps described in Section 3.1.3 to load the example to both devices.

The results of the execution can be observed on LED0 of the master which should stay off; unless the communication with the slave is interrupted (i.e. pressing the reset button on the slave).

The pin used for LED0 depends on the device and it’s listed on Table 4.

The results can also be observed using the debugger or a logic analyzer as shown in the following figure:

![Figure 10: Results of 01_ReadByte_Echo example using Logic Analyzer](image)

3.4 02_WriteWord_Dimmer

This example shows a very basic implementation of a WriteWord command controlling a LED dimmer on the slave.
### 3.4.1 Master Implementation

The master sends a WriteWord command which changes the duty cycle of a PWM controlled by the slave. The duty cycle starts at 0%, increases gradually to 100% and restarts.

![Flow diagram of Master implementation](image)

**Figure 11: Master02_WriteWord_Dimmer flow diagram**

### 3.4.2 Slave Implementation

The slave device in this application implements a single Write Word command which controls the PWM duty cycle. The PWM output depends on the device and is described in Table 5.

For a description of the SMBus Write Word protocol, please refer to the [SMBus 2.0 specification](#).
3.4.2.1 Set_Duty_Cycle

**Description:** Sets the duty cycle of the PWM

**Protocol:** Write Word

**Format:**

<p>| | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>SlaveAddr</td>
<td>Rd</td>
<td>A</td>
<td>CMD</td>
<td>A</td>
<td>DataL</td>
<td>A</td>
<td>DataH</td>
<td>A</td>
<td>[PEC]</td>
</tr>
</tbody>
</table>

**CMD:** 0x10

**DataL/DataH:** Duty cycle from 0x0000 to 0xFFFF. With 0x0000 being 0% and 0xFFFF being 100%.

3.4.3 Executing the Example

Follow the steps described in Section 3.1.3 to load the example to both devices.

The results of the execution can be observed if an LED is connected to the PWM output shown in Table 5. The LED will increase gradually until it reaches 100% and then it will restart.

The results can also be observed using a logic analyzer as shown in the following figure:

![Figure 12: Results of 02_WriteWord_Dimmer example using Logic Analyzer](image-url)